
 

 

Geospatial Databases: Metadata, 
Standards, and Infrastructure 

What is metadata? 

Information that describes items in ArcGIS is called metadata. When care is taken to provide 

good descriptions, you can find appropriate items with a search and evaluate which of the items 

in your search results is the correct one to use. 

In an item's metadata you can record whatever information is important for your organization to 

know about that item. This might include information about how accurate and recent the item is, 

restrictions associated with using and sharing the item, important processes in its life cycle such 

as generalizing features, and so on. 

You view and edit an item's metadata in the Description tab, either in ArcCatalog or by opening 

the Item Descriptionwindow from other ArcGIS for Desktop applications. 



 

A metadata style configures ArcGIS to create the metadata you want. Choosing a metadata style 

is like applying a filter to an item's metadata. The style controls how you view the metadata and 

also the pages that appear for editing metadata in the Description tab. A metadata style may be 

designed to support a metadata standard or profile. If so, the style will determine how metadata is 

exported and validated for that standard or profile. 

The default Item Description metadata style lets you see and edit a simple set of metadata 

properties for an item. Only one page of information is available when editing metadata with this 

style. This style is designed to facilitate providing information that is used by ArcGIS; it is 

indexed and available for searching and can be published with the item to ArcGIS Online. 

The Item Description metadata style is straightforward and effective, suitable for anyone who 

doesn't need to adhere to specific metadata standards. 



ArcGIS offers several different metadata styles. If you want to view more information about the 

item or describe it in more detail than you can with the default Item Description style, choose a 

different metadata style. 

 

All of the other metadata styles provided with ArcGIS let you view an item's complete metadata. 

When you click the Editbutton you'll see many pages in the Description tab that let you type 

detailed information.  

 

 

 

 

 

 



These metadata styles let you manage metadata appropriately for different standards or profiles, 

including the Content Standard for Digital Geospatial Metadata (CSDGM) created by 

the Federal Geographic Data Committee (FGDC), ISO standard 19139 Geographic information 

— Metadata — XML schema implementation, the North American Profile of ISO 19115:2003 – 

Geographic information – Metadata (NAP), and the European INSPIRE Metadata Directive. 

Some of these styles will have extra pages in the editor's table of contents, or a common page 

will work differently to let you provide content specific to that style. The metadata style also 

knows how to export content provided in the Description tab to a stand-alone XML file that is 

formatted correctly for a standard or profile, and how to validate those files using the appropriate 

XML schema. You may want to publish the exported XML file to a metadata catalog such as the 

European INSPIRE geoportal or the United States GeoPlatform.gov. If you must create metadata 

that complies with a specific metadata standard or profile, be sure to choose the appropriate 

metadata style. 

After creating, editing, validating, and exporting metadata for a few items, you'll start to look for 

ways to streamline your workflow. You can create template metadata documents that contain 

information common to many items. Import the metadata template before adding details that are 

specific to that one item. Aside from editing, all metadata tasks can be accomplished using 

geoprocessing tools that are available in the Conversion toolbox. You can import a metadata 

template, update contact information, and so on, for many items at once by running a 

geoprocessing tool or model in batch mode or creating an appropriate Python script. Other 

scripts can be automated, for example, to periodically export metadata for many items so updated 

information can be published to a metadata catalog. 

The metadata editor and buttons in the Description tab, the buttons on the Metadata toolbar 

in ArcCatalog, and most of the metadata geoprocessing tools are designed to work with 

information stored in the new ArcGIS metadata format. If you have metadata created with 

ArcGIS Desktop 9.3.1 or the FGDC metadata editor add-in, or a stand-alone XML file 

containing metadata stored in a standard-compliant format, you can view that content in the 

current version of ArcGIS for Desktop, but it is read-only. Existing content must be upgraded to 

http://links.esri.com/metadata_geodata_us


the new format, or standard-compliant XML files must be imported to ArcGIS before you can 

edit content and use the buttons in the Description tab. 

If you created metadata using the FGDC metadata editor in ArcGIS Desktop 9.3.1 or the FGDC 

metadata editor add-in, this content is visible under the FGDC Metadata (read-only) heading in 

the Description tab. You can export and validate this content using the USGS MP Metadata 

Translator tool. 

 

Essential metadata vocabulary 

This topic provides an overview of some of the terms you will encounter when working with 

metadata in ArcGIS. Not all these terms are specific to ArcGIS. 

Term Definition 

Description All ArcGIS items have a description, which is also referred to as metadata. 

Metadata 
An ArcGIS item's description. In ArcGIS, metadata can optionally conform to a 

geospatial metadata standard. 

Metadata 

element 

An individual piece of information in an item's metadata. A metadata element may 

contain a value such as a title or date, or it may contain other metadata elements. 

Metadata 

standard 

A document identifying content that should be provided to describe geospatial 

resources such as maps, map services, vector data, imagery, and relevant nonspatial 

resources. A metadata standard may also describe the format in which the content 

should be stored. 



Term Definition 

Standards are typically created or ratified by national or international standards bodies. 

Many geospatial metadata standards are produced by ISO including ISO 

19115, Geographic Information - Metadata, ISO 19119, Geographic Information - 

Services, and ISO 19139, Geographic Information - Metadata - XML Schema 

Implementation. 

Metadata profile 

A document identifying modifications to a metadata standard that has been adopted 

by a standards body, agency, or organization. A profile may reduce the overall number 

of metadata elements that were originally included in a standard. A profile may further 

restrict the optionality of a metadata element, making it mandatory where before it 

was optional; a profile may not make mandatory elements optional. A profile may 

further restrict the values allowed in a metadata element. One example of a metadata 

profile is the North American Profile of ISO 19115:2003, Geographic Information - 

Metadata. 

Metadata style 

The metadata configuration used in ArcGIS. A metadata style identifies the metadata 

standard you are following, the appearance of metadata when you view it, the pages 

included in the ArcGIS metadata editor, the XML schema used to validate metadata, 

and how to export metadata to an XML file that is formatted correctly for the XML 

schema. 

Stand-alone 

metadata 

An XML file containing geospatial metadata that is not associated with an ArcGIS item. 

Some items can't be described in ArcGIS. Other geospatial resources, such as atlases 

and globes, aren't handled by ArcGIS at all. Nevertheless, you can describe these 

resources by creating XML files and using the ArcGIS metadata editor to record 

information about them. 



Term Definition 

This naming convention distinguishes XML files containing geospatial metadata that 

aren't associated with ArcGIS items from XML files containing other data such as 

geodatabase XML documents. 

Metadata 

synchronization 

The process of automatically updating an item's metadata to reflect the current 

properties of the item. That is, values in the metadata are being synchronized with the 

item's properties. When an item's metadata is synchronized, metadata will be created if 

it doesn't already exist. 

Metadata catalog 

A searchable online collection of metadata describing geospatial resources. One 

example of a metadata catalog is the U.S. collection of maps and 

data GeoPlatform.gov. The Internet or intranet site from which you access and search 

the metadata catalog is often referred to as a GIS catalog portal. 

 

 

Viewing metadata 

 
 

Viewing metadata from the Catalog window 

Look at an item's metadata to see if it has the data you need to add to your map. 

1. Right-click the item whose metadata you want to see. 

2. Click Item Description. 

The Item Description dialog box opens. The item's metadata is displayed in the Description tab. 

http://links.esri.com/metadata_geodata_us
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Once the Item Description window is open and the Description tab is selected, if you click 

another item in the Catalogwindow, you'll see its metadata immediately. 

 

 

Viewing metadata from ArcCatalog 

Look at an item's metadata to see if it's what you're looking for. 

1. In ArcCatalog, click the item whose metadata you want to see. 

2. Click the Description tab. 

The item's metadata is displayed. 



 

Viewing metadata from the Table of Contents 

When using a map you can see metadata describing the layer's or table's source data from 

the Table of Contents window. 

Note: 

This will not show the description of the layer or table as they are in the map, for example, with 

definition queries applied and specific fields selected for use. You'll see the description of the 

entire underlying dataset in the geodatabase or on disk. 

1. Right-click the layer or table whose metadata you want to see. 

2. Click Data > View Item Description. 

The Data Source Item Description dialog box opens and displays the item's metadata. 



 

 

Choosing a metadata style 

The information available for viewing and editing in the Description tab is determined by the 

current metadata style. The default metadata style, Item Description, lets you see and edit a 

concise description of an item. It shows you a small set of information that is a portion of the 

item's complete metadata document. This set of information can be published to ArcGIS 

Online with the item and is available for searching. For many people, this level of detail is 

sufficient on a daily basis. 

If you are a metadata specialist or you want to see or edit more information than is available by 

default, choose a different metadata style that gives you complete access to the item's metadata. 

The same description is shown at the top of the page, followed by sections that give you access 

to the rest of the information under the ArcGIS Metadata heading. 

In addition to determining the information available for viewing and editing, the metadata style 

identifies the metadata standard you are following, the XML schema that can be used to validate 



an item's metadata for the standard, and how to export metadata to an XML file that is formatted 

correctly for the standard. 

Choose the style of metadata you want to create before you start editing metadata. 

Caution: 

If you start creating metadata using one metadata style and later switch to a different style, the 

pages in the Description tab may change. Information you added before may no longer be 

visible or accessible with your current metadata style. 

1. Open the Options dialog box for your ArcGIS for Desktop application. 

o In ArcMap, click Customize > ArcMap Options. 

o In ArcCatalog, click Customize > ArcCatalog Options. 

o In ArcGlobe, click Customize > ArcGlobe Options. 

o In ArcScene, click Customize > ArcScene Options. 

The Options dialog box appears. 

2. Click the Metadata tab. 

3. Click the drop-down arrow and click the style of metadata you want to create. 



 

4. Click OK. 

Note: 

If you're using the Description tab when you choose a new metadata style, you won't immediately see 

the results of that change. Click another tab in ArcCatalog or the Item Description window, such as 

the Preview tab, then click the Description tab again for the new metadata style to take effect. 

 
 
 

The ArcGIS metadata format 

 ArcGIS metadata XML elements 

 Upgrading to ArcGIS metadata 

 More about FGDC metadata 

Metadata is part of an ArcGIS item. When the item is copied in ArcGIS, its metadata is also 

copied. When the item is imported into a geodatabase, its metadata is also imported. Metadata is 

stored in the same location as the item's data in a manner that is appropriate for its data type. For 

example, metadata is stored in the same location on disk as a shapefile's data in an accompanying 

XML file. For geodatabase items, metadata is stored in the geodatabase system tables. If your 

data is stored in an enterprise geodatabase, see the topic that describes the geodatabase system 



tables for your DBMS to learn more; metadata is stored in the Documentation column in the 

GDB_Items table. 

ArcGIS provides access to metadata for all items as an XML document, regardless of how it is 

physically stored. The ArcGIS metadata editor reads and stores information in a specific set of 

XML elements in that document. Collectively, these elements are referred to as the ArcGIS 

metadata format. 

The current version of ArcGIS is designed to create, maintain, and use information stored in the 

ArcGIS metadata format. 

The ArcGIS metadata format contains elements that can store all content in all metadata 

standards that are supported by ArcGIS for Desktop. It includes all FGDC metadata content, all 

ISO 19139 metadata content, all North American Profile metadata content, and all INSPIRE 

metadata content. It also includes ArcGIS-internal content such as thumbnails, enclosures, and 

detailed properties of ArcGIS items; this information is useful, but is not included in official 

metadata standards and profiles. 

 

ArcGIS metadata includes content for all standards. 

No matter which metadata standard or profile you are following, you enter content with one 

editor—the ArcGIS metadata editor. No matter which metadata style you use, all information 

that you provide in the Description tab is stored in the same manner in the item's metadata—in 



the ArcGIS metadata format. By default, when you view an item's metadata, ArcGIS 

automatically records information about its intrinsic properties in its metadata in a process 

known as synchronization; these properties are only stored and updated in the ArcGIS metadata 

format. 

Choosing a metadata style is like applying a filter to ArcGIS metadata. The ArcGIS metadata 

editor and the underlying ArcGIS metadata format remain the same, but the new filter changes 

your metadata experience. It can alter how much metadata content is viewed and how it is 

displayed, and which pages are included in the editor and how they work. For metadata styles 

designed to support a standard or profile, the filter ensures you are working with content that is 

appropriate for that standard or profile as well as information that is important in ArcGIS, such 

as thumbnails and field descriptions. While different styles might give you access to more or less 

metadata content, that information is always ArcGIS metadata. 

 

A metadata style filters an item's ArcGIS metadata so you only work with appropriate content for that 

style. 

If you are creating FGDC-style metadata today, and a year from now your organization decides 

to create North American Profile-style metadata instead, that's OK. To make that change you 

only need to change your metadata style in ArcGIS. When you change your metadata style, all of 

the content you entered before is still exactly the way you left it because metadata content is 

stored the same way for all metadata styles. You might be required to provide some different 



information than before to comply with the new standard's rules, but you don't need to change 

anything else. 

ArcGIS metadata XML elements 

For new items created with the current version of ArcGIS, if you view and edit their metadata in 

the Description tab, that metadata will only contain information stored in the ArcGIS metadata 

format. However, if an item has existed for some time, its metadata likely has content that was 

created using ArcGIS Desktop 9.3.1 or an earlier release. Its metadata content is likely stored in 

either the FGDC or ESRI-ISO metadata XML formats alongside other ArcGIS-internal 

information. 

The 9.3.1 FGDC metadata editor and utilities created, displayed, and managed content in the 

native FGDC metadata XML format inside an item's metadata. The 9.3.1 wizard-style ISO 

metadata editor and utilities created, displayed, and managed content in the ESRI-ISO XML 

format. The FGDC format XML elements and the ESRI-ISO format XML elements are mutually 

exclusive. If both metadata editors were used, an item's metadata would contain two copies of 

the same information in parallel sets of XML elements. Supporting other standards involved 

adding custom editors and utilities for creating, displaying, and managing content; these would 

typically manage content in additional sets of parallel XML elements. 

The ArcGIS metadata format borrows a few XML elements from the FGDC XML format—the 

elements that describe an item's attributes. It also borrows many XML elements included in the 

ESRI-ISO XML format; in some respects you can think of the ArcGIS metadata format as 

version two of the ESRI-ISO format. However, ArcGIS metadata also includes many new XML 

elements, as well, and stores some of the same information in a new way. 



 

When you view metadata for existing items, new synchronized ArcGIS metadata elements will 

automatically be added alongside any existing FGDC-formatted or ESRI-ISO-formatted 

metadata content. 

When you use any metadata style that supports viewing an item's complete metadata, you can 

see all content stored in the ArcGIS metadata format under the ArcGIS Metadata heading. If 

the item's metadata includes content stored in the ESRI-ISO metadata format, it will be upgraded 

automatically when you view the metadata. Therefore, you'll see this content under the ArcGIS 

Metadata heading as ArcGIS metadata. Upgrading existing ESRI-ISO metadata is discussed 

further below. 

You can also see any content stored in the FGDC metadata format under the FGDC Metadata 

(read-only) heading; this heading only appears if FGDC-formatted metadata exists. Content that 

is shared between the FGDC format and the ArcGIS metadata format will appear under both 

headings. 



 

While you can see FGDC-formatted content, this information is only available for viewing in 

the Description tab, which is why the information is identified as being read-only. 

Upgrading to ArcGIS metadata 

If an item has existing metadata content that is not in the ArcGIS metadata format, the current 

version of ArcGIS for Desktopcan't use that information. For example, the ArcGIS metadata 

editor and the Export and Validate buttons only work with content that is stored in the ArcGIS 

metadata format. When you use the Import button, the metadata content you are importing is 

converted to the ArcGIS metadata format. 

There is no need to retype all of an item's existing metadata in the Description tab. A 

geoprocessing tool is available to upgrade existing FGDC-formatted metadata content or ESRI-

ISO-formatted metadata content to the ArcGIS metadata format. 

The Upgrade Metadata tool copies information in existing FGDC or ESRI-ISO metadata 

elements that are not included in the ArcGIS metadata format to the equivalent ArcGIS metadata 

elements. Upgrading doesn't alter the item's ArcGIS-internal content: the geoprocessing history, 



thumbnail, enclosures, and so on. Upgrading doesn't remove any existing FGDC- and ESRI-ISO-

format elements. Properties of the item that were recorded in its metadata by ArcGIS Desktop 

9.3.1 aren't upgraded. The current version of ArcGIS automatically updates the item's metadata 

to include its current properties at the end of the upgrade process. 

After upgrading, your original metadata content is available in the Description tab for editing, 

validating, exporting, and other operations in ArcGIS. If you have been creating metadata 

following the FGDC CSDGM metadata rules and guidelines, the arrangement and names of 

elements will be a bit different than you are accustomed to in the ArcGIS metadata editor, but all 

of the FGDC metadata concepts are available in the Description tab. 



 

Upgrade either existing FGDC-formatted information or ESRI-ISO-formatted information to ArcGIS 

metadata to edit it in the current release. 

If an item has existing metadata in the ESRI-ISO format that was typed by a person—not 

automatically added by ArcGIS 9.3.1—it is upgraded automatically to ArcGIS metadata when 

you view it in the Description tab. The automatic upgrade is not permanent; it is discarded 

unless you edit the item's metadata and save your changes in the Description tab. 



In contrast, existing FGDC-format metadata is not upgraded automatically. You will be notified 

that your existing FGDC-format metadata must be upgraded to the ArcGIS metadata format 

before it can be used in the Description tab when all of the following are true: 

 Some of the item's FGDC-format metadata content was typed into a metadata editor—not added 

automatically by ArcGIS Desktop 9.3.1. 

 No content was typed into a metadata editor that stored information in the ESRI-ISO metadata 

format—content added automatically by ArcGIS Desktop 9.3.1 in this format is ignored. 

 No metadata was typed into the Description tab and saved anywhere except the Item 

Description page. 

 

Click Yes to upgrade the existing FGDC metadata content right away. The Upgrade Metadata 

tool opens and the Upgrade Type is automatically set to FGDC_TO_ARCGIS. If you would rather 

wait, click No. The Upgrade button  will be available in the Description tab. You can use it 

later to upgrade the item's metadata. If you prefer not to be notified when existing FGDC 

metadata content hasn't been upgraded, check the option Do not show this message in the 

future. Notifications can be enabled again in the Options dialog box for your ArcGIS for 

Desktop application. 



 

If an item's metadata includes existing content typed by a person in both the FGDC and ESRI-

ISO metadata elements, you must choose one set of information to upgrade to ArcGIS metadata. 

You should upgrade whichever set of metadata is more complete to ensure you don't lose 

important information. Usually, the FGDC metadata content will be more complete. 

If you prefer to upgrade metadata for many items at once instead of one at a time, run the 

Upgrade Metadata tool in batch mode or with a Python script using the appropriate upgrade type. 

For example, you might upgrade metadata for all items in a folder or geodatabase. 

More about FGDC metadata 

If you edit metadata using the FGDC metadata editor add-in, it adds and edits content in the 

native FGDC metadata XML format inside an item's metadata. This content is displayed under 

the FGDC Metadata (read-only) heading. 

Upgrading existing FGDC metadata content is strongly recommended to support basic 

operations in the current version of ArcGIS for Desktop that involve metadata. 

http://desktop.arcgis.com/en/arcmap/10.3/analyze/executing-tools/a-quick-tour-of-batch-processing.htm
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If you don't upgrade, you can search for items in ArcGIS, and publish them to ArcGIS Online. 

When information isn't found in the ArcGIS metadata elements associated with the Item 

Description metadata style, ArcGIS will look for information in the related FGDC metadata 

elements and index or publish that content instead. In the same manner, you can view an item's 

simple Item Description summary. However, the rest of the item's FGDC metadata content 

remains unavailable. Most of the existing content won't appear under the ArcGIS 

Metadata heading. The buttons in the Description tab won't process any FGDC-format 

metadata. ArcGIS won't automatically update it with the item's current properties. Other 

operations in ArcGIS may not find the information they are looking for and require you to retype 

some information. 

If the item's existing FGDC metadata hasn't been upgraded, and you start editing metadata in 

the Description tab, the Item Description page displays the same content as the simple Item 

Description display and the Field page shows the existing FGDC attribute descriptions. The 

other pages will be empty except for any synchronized properties that you can edit. If you edit 

information on the Item Description page, your edits are saved in both the FGDC metadata 

elements and the corresponding ArcGIS metadata elements. If you edit information on 

the Fields page, your edits are saved in the FGDC metadata elements, which are shared with 

ArcGIS metadata. If you add content using any other page, your changes are saved to the 

appropriate ArcGIS metadata elements only. 

Once an item's metadata includes ArcGIS metadata content that was upgraded or typed by a 

person, any future indexing and publishing operations only use information stored in the ArcGIS 

metadata format. Also, the simple Item Description display and the Item Description page in the 

ArcGIS metadata editor will only show and update ArcGIS metadata elements—the associated 

FGDC metadata elements will no longer be updated. 

When FGDC metadata is upgraded to ArcGIS metadata, a copy of the item's original metadata 

document is stored within the item's metadata as an enclosure for reference. You can access it 

using the Metadata Properties button on the ArcCatalogMetadata toolbar. 



Editing metadata 

 
 

A quick tour of creating and editing metadata 

 Describing a collection of GIS resources 

 A plan for metadata 

 What documentation to provide 

The Description tab lets you view and edit metadata for ArcGIS items and stand-alone metadata 

XML files. The pages available for editing metadata help you author content correctly for 

your metadata style. The default value for metadata style, Item Description, lets you create a 

concise description for an item. To create complete metadata for an item instead, choose a 

different metadata style. 

The current version of ArcGIS for Desktop is designed to support creating and managing ArcGIS 

metadata in the Description tab. If an ArcGIS item or an XML file has existing metadata that 

was created using ArcGIS Desktop 9.3.1 or an earlier release, it must be upgraded to the ArcGIS 

metadata format before you can edit the existing content. 

Existing ESRI-ISO metadata will be upgraded automatically when you start editing the item's 

metadata with the current release of ArcGIS. 

If an item has existing FGDC metadata, you don't need to upgrade to ArcGIS metadata to 

maintain the level of information available with the default Item Description metadata style. 

This lets you easily maintain the amount of information necessary to publish resources 

to ArcGIS Online. Any changes you make on the Item Description page will update both the 

ArcGIS metadata elements and the associated FGDC metadata elements, if they are present in 

the item's metadata. 

However, to maintain an item's complete, standard-compliant metadata using 

the Description tab you must first upgrade the existing FGDC metadata to ArcGIS metadata. 



Complete FGDC metadata content won't be upgraded automatically—your organization must 

decide when it is appropriate for you to upgrade. For example, you might have to modify your 

workflow for validating and publishing metadata before you can upgrade and start using the 

ArcGIS metadata editor to maintain your content. 

In the meantime, you can continue to maintain your FGDC metadata content using the FGDC 

metadata editor add-in. This add-in provides a button that can be added to 

the ArcCatalog Metadata toolbar. When clicked it will open the same FGDC metadata editor 

provided with ArcGIS Desktop 9.3.1 and earlier releases. All FGDC metadata content must be 

updated manually. The current version of ArcGIS only automatically updates content in ArcGIS 

metadata elements. 

Describing a collection of GIS resources 

Most items in ArcGIS let you create metadata describing them. Each ArcGIS item has an 

individual metadata document that is not interconnected with other related ArcGIS items. For 

example: 

 A feature class' metadata describes only that feature class—it does not inherit any information from 

metadata for the feature dataset in which the feature class is stored. 

 A feature dataset's metadata describes only that feature dataset—it doesn't aggregate information 

about all the feature classes it contains. 

 A layer file's metadata should describe only the layer and not the underlying data. It might describe 

the map scales where the data will be displayed, why the data was normalized using the chosen 

method, and how the features included in the layer were selected. The feature class should be 

documented as a related resource. 

 A map service's metadata should describe only the map service. If appropriate, the underlying map 

and the data services it contains should be documented as related resources. 

If you have already created metadata describing a feature dataset, you don't need to retype 

portions of its description into the metadata for all the feature classes it contains. You can import 

the feature dataset's description to the feature class using the Import button in 



the Description tab and the FROM_ARCGIS import type. The feature dataset's description will be 

copied, while the intrinsic properties of the feature dataset will not—the intrinsic properties of 

the feature class will be added automatically. Be sure to update the imported description so it 

correctly describes the item. By the same token, metadata can be copied from one item to other 

related items using the same workflow. 

If some information is the same for many items, the best workflow is to create a metadata 

template that exclusively contains the common information. Then, import the template to an item 

before you start creating its metadata. 

ISO metadata standards support the idea of maintaining information at different hierarchical 

levels in a GIS. For example, you might create metadata describing an entire series of imagery 

instead of creating almost identical descriptions for each image in the series. In ArcGIS, you can 

create metadata describing more granular resources such as a series or an entire data product by 

creating a stand-alone metadata XML file and adding metadata to it in the Description tab. 

ISO metadata standards also suggest that you can create metadata describing parts of an item 

such as the attributes or features in a feature class. Creating metadata at this level of detail is not 

supported in ArcGIS. Information about a feature should be documented in the feature class' 

attribute table. Information about an attribute can be documented in the Fields section in the 

feature class' metadata. 

Note: 

In an ArcSDE geodatabase, metadata can only be created to describe items in the default version. 

Individual transactional or historical versions of the geodatabase can't have metadata that is 

specific to the items in that version. If you change metadata when you are using a transactional 

or historical version of the geodatabase, your changes will be seen by everyone using the default 

version of the geodatabase; your changes may not be relevant for the default version. 



A plan for metadata 

As with any project, you'll need a plan in place for your organization identifying what items need 

metadata, which metadata standard or profile you're going to follow, and who is responsible for 

completing what portion of the documentation. Even if one person enters all the metadata, that 

person needs the people who created the data to provide information about how it was created 

and tested, for example. It helps to have organizational support to ensure that all participants will 

contribute their time and knowledge so the project will succeed. 

If several people will be creating metadata, the manager of the metadata project should create 

metadata templates for others to use and provide some guidelines to ensure consistency. This 

person should also check that completed metadata is valid and coordinate publishing completed 

metadata to a metadata catalog if you decide to share your information. 

When developing guidelines for your organization, be sure to use common sense. There is more 

to consider than the rules of a metadata standard. Your metadata should be as complete as it 

needs to be for its intended purpose. The absolute minimum amount of information required to 

make metadata valid for a metadata standard may be insufficient to find it when you search a 

metadata catalog. The absolute minimum amount of information required to publish metadata to 

a metadata catalog may be insufficient for it to be valid for a metadata standard. 

Most of your effort should be spent documenting the data you use most, as it is the most valuable 

to your organization. 

After creating metadata for a few metadata items, be sure to review the work. If the metadata has 

been published to a metadata catalog, do some searches to see if you can find your documents. 

You may want to modify your guidelines to improve the work you do in the future. 

What documentation to provide 

Metadata elements can typically be divided into two categories: documentation and properties. 



Documentation is descriptive information supplied by a person when he or she edits information 

in the Description tabsuch as the units of measure for data stored in a field and the information 

that data represents. Good documentation protects your investment in the resources you have 

created. You can have more confidence in your decisions when you know your data is accurate, 

current, and came from a reliable source. 

Properties describe inherent characteristics of the item such as the extent of features in a feature 

class or the location of a text file. By default, ArcGIS derives an item's properties and adds them 

to its metadata automatically when metadata is viewed, validated, exported, and imported. 

Properties can also be updated in an item's metadata using the Synchronize Metadata tool 

whenever it is appropriate to do so. Adding properties to metadata automatically supplements 

good documentation and helps reduce metadata maintenance costs. Because ArcGIS 

automatically handles the properties, all you need to worry about is completing the 

documentation. 

If metadata is automatically created and updated by ArcGIS, when you view it, you will always 

see current information describing the item. Information that is maintained automatically is best 

left unmodified except for the default title of the item. If you change an automatically added 

value, the metadata element changes categories—from properties to documentation—and the 

value won't be updated automatically in the future if the item changes. 

In general, your metadata should cover the who, what, when, where, why, and how of the 

ArcGIS item. Here are just a few tips to get you thinking before you start editing metadata: 

 ArcGIS will index the title, abstract, purpose, keyword, and credit metadata elements for searching. 

 Since "now" will become "then," and you will forget, try to provide a real date or a range of dates 

describing when the data was created. Avoid using relative terms like now or present unless people 

truly update a resource daily over an extended period of time. 

 Consider the date of the source data when describing the date of an item. Data created today using 

an image that is six months old is really six months old. You can enter two times, one for when the 



image was captured and one for when the data was created from the image; just be sure to indicate 

which date is for which event. 

 When providing contact information, try to use a position name or the name of a group instead of a 

person's name unless creating the data is truly an individual effort. People leave an organization or 

change roles, and the cost of updating metadata to change a person's name is not insignificant. 

 If you produce different versions of a map or data, it is important to identify which version you are 

describing with the edition metadata element in the item's citation. The version being described 

might be obvious when you are in ArcGIS, but if the metadata is published to a metadata catalog, it 

might not be easy to determine. 

 Thumbnails aren't strictly part of any metadata standard, so not all metadata catalogs support them. 

However, when you search a metadata catalog based on Esri software, a thumbnail can help you 

decide immediately if you've found the right item. 

 If someone who has never seen your data before wants to use it, what do they need to know? What 

are they allowed to do with it? 

 

Editing metadata 

You edit an item's metadata in the Description tab. Some ArcGIS metadata elements associated 

with the brief Item Description support formatting their text. Formatting is supported to make the 

information provided in a longer description easy to read and understand when it is published 

to ArcGIS Online. The elements that support formatting are indicated by the presence of buttons 

that can be used to format the text. Use these buttons to make your text bold, add links to web 

pages, provide information in a bulleted list, and so on. 

Note: 

HTML tags should never be typed directly into any element's text to provide formatting 

instructions. For example, do not type tags such as <b> and </b> around text to try to make it 

appear bold. You will end up seeing these tags as text in the item's metadata. 

While text formatting may improve communication with other ArcGIS users, it isn't supported 

by any metadata standard. If formatting has been added to an element's metadata content, it will 



be removed when the item's metadata is exported to an XML file that follows a standard 

metadata format. 

When you provide a longer description, you may want more room to type. You can make any 

multiline text box bigger by clicking the shaded triangle on the bottom corner of the text box and 

drag it down until the text box is as big as you want it to be. This gives you more room to type 

while still being able to see the rest of the content you've already provided. It can help you reread 

and edit your content. 

 

To describe a relevant date or time period for an item, you'll see a calendar icon if a date isn't 

already stored in a metadata element. Click it to select an appropriate date using the calendar 

control. It will open with today's date shaded gray. A year, month, and day must be specified. 



 

In the calendar, you can scroll through the months using the arrows or click the month and year 

at the top to pick from a list. Click the year at the top of the calendar again to pick from a list of 

years. 

  

The selected date appears on the page. If the time the event occurred is significant, you can 

change the default time, 00:00:00. Click the up and down arrows to set the hour, or click the 

hour and type the appropriate number using the 24-hour time notation. To set the minutes or 

seconds, click that portion of the time and type the appropriate number. 

 

If you're ever unsure of what information to provide in a metadata element, hover the pointer 

over its input control. A help string appears at the bottom of the editor explaining what 

information is expected. 



 

All metadata styles provided with the current version of ArcGIS for Desktop, other than the Item 

Description style, are designed to support a specific metadata standard or profile. These metadata 

styles include rules about the elements that are required to create metadata that complies with 

those standards. If a metadata element has a red background, this indicates there is a problem 

with its value. A value may be mandatory in this metadata element with the current metadata 

style, but one hasn't been provided. Or, the wrong type of value may have been provided for the 

element. For example, if an element is supposed to contain an integer but instead a real number 

has been provided, the element's input control will have a red background. 



 

Learn about creating standard-compliant metadata 

These metadata styles also include a Contacts Manager page that lets you save frequently used 

contact information. The first time you use this page, it lists all contacts that have already been 

provided in the item's metadata. Check Save for any contacts you want to reuse later. If the same 

contact can have many roles, such as the item's publisher, distributor, and point of contact, you 

may want to save the contact with no role specified. Contact information can't be edited on this 

page; it can only be used to manage saved contacts. 

http://desktop.arcgis.com/en/arcmap/10.3/manage-data/metadata/creating-standard-compliant-metadata.htm


 

On pages where you provide contact information, you can either load contact information that 

was previously saved, or provide a new contact. To load saved contact information, click the 

appropriate contact in the drop-down list, then click Load; a copy of the saved contact 

information is added to the item's metadata. If you saved a contact without a role, be sure to set 

the contact's role appropriately for this location in the item's metadata. 

 



If you later type in new contact information or you're working with another item's metadata that 

has contacts you want to save, revisit the Contacts Manager page. The saved contacts are listed, 

followed by any contacts in the item's metadata that don't match the saved contacts. Even if all 

names and contact information are the same, two contacts won't match if they have a different 

role. Save will be checked for all contacts that were previously saved. Check Save for any new 

contacts you want to keep. Uncheck Save to remove a previously saved contact. 

 

It may take some time to fully complete an item's metadata. You can save your changes and stop 

editing at any time, then come back later and finish your work. You can stop editing even if the 

pages indicate you're missing information that is required for your metadata style or if some 

information is considered invalid for a metadata element. 

For items such as maps, globes, and scenes, some of the information you can edit on the Item 

Description page in the Description tab is also available in the item's Properties dialog box. If 

you edit this information in the Description tabyou'll see those changes the next time you open 

the item's Properties dialog box. If you edit this information in the Properties dialog box when 

the document is open, those changes are saved in the item's metadata when you save the map, 

globe, or scene. If you edit this information when you access the Properties dialog box 

from the Catalog window, those changes are saved in the item's metadata when you click OK. 

1. In the Catalog window, click the item you want to describe. 

2. View the item's metadata. 



3. Click the Edit button  in the Description tab. 

 

If the Edit button is not visible, you do not have permission to edit metadata for this item, and you 

won't be able to complete this task. The shared network location or the item's files may be read-only, 

or you may not have permission to edit the data for this item in the geodatabase. 

The pages used to edit metadata appear in the Description tab. 

 



4. Describe the item using the available pages. 

Metadata elements with a red background are mandatory for your metadata style or contain the wrong 

type of information such as a string instead of a number. 

5. Stop editing. 

o Click the Save button  to save your changes. 

o Click the Exit button  to stop editing without saving your changes. 

The current metadata is displayed in the Description tab under the ArcGIS Metadata heading. 

Creating a thumbnail from the Preview tab 

You can create a thumbnail for most items, which can be previewed in the Preview tab. The 

thumbnail is stored in the item's metadata. 

1. In the Catalog window, click the item for which you want to create a thumbnail. 

2. View the item's metadata. 

3. Click the Preview tab. 

4. Click the Zoom In button  on the Geography toolbar and zoom to the area that best represents 

the item's contents. 

5. Click the Create Thumbnail button  on the Geography toolbar. 



 

The thumbnail records what you currently see in the preview. 

Creating a thumbnail for maps, globes, and scenes 

Map, globe, and scene documents can have a thumbnail illustrating the document's layout. 

Thumbnails for these items are stored inside the document itself; they are not stored in the item's 

metadata. 

1. Open the map, globe, or scene document for which you want to create a thumbnail. 

2. Open the document's Properties dialog box. 

o In ArcMap, click File > Map Document Properties. 

o In ArcGlobe, click File > Globe Document Properties. 

o In ArcScene, click File > Scene Document Properties. 

3. Click the Make Thumbnail button. 



o If the document doesn't have a thumbnail, the Make Thumbnail button will be available. 

o If the document already has a thumbnail, the Delete Thumbnail button will be available. 

Click this button to remove the existing thumbnail, then click the Make Thumbnail button to 

create a new one. 

 

Note: 

If you open the document's Properties dialog box from the item's shortcut menu 

in the Catalog window, the Make Thumbnail and Delete Thumbnail buttons will be unavailable. 

The document must be opened in the appropriate ArcGIS for Desktop application to create a 

thumbnail for it. 

4. Click OK. 



The thumbnail records the document's current layout. 

 

Creating a thumbnail from the Description tab 

For some items such as tables it isn't possible to capture a thumbnail describing it using ArcGIS. 

For these items, you can enclose a graphic file in the item's metadata that can be used as its 

thumbnail when you edit the item's metadata in the Description tab. You can also remove or 

replace an existing thumbnail, if appropriate. 

1. In the Catalog window, click the item for which you want to create a thumbnail. 



 

2. Start editing the item's metadata. 

The pages used to edit metadata appear in the Description tab. 

3. Click the Item Description page if a list of pages for editing metadata is provided. 

4. Click the Update button under the thumbnail or the placeholder where the thumbnail should be. 

 



5. Navigate to and click the graphic file you want to use as the item's thumbnail. 

The recommended image size is 200 pixels wide by 133 pixels high. When the thumbnail is displayed, 

the image is sized to fit these dimensions. For best resolution, add an image of size 200 x 133. 

6. Click Open. 

A copy of the graphic file is enclosed in the item's metadata and used as its thumbnail. The original 

image is converted to JPEG format if appropriate. 

 

7. Click the Save button  to save your changes. 

The enclosed graphic file is displayed as the item's thumbnail. 

 



 

Creating standard-compliant metadata 

 Creating standard-compliant metadata in ArcGIS for Desktop 

 Validating an item's metadata 

 Exporting and publishing a standard-compliant XML file 

Complexity: 

Beginner 

Data Requirement: 

Use your own data 

Typically, you create metadata that follows a metadata standard or profile because you need to 

share information about your GIS resources with others. The standard or profile provides an 

agreed-on format for exchanging information in your community. 

If you are creating metadata that complies with an official standard or profile, you should refer to 

your copy of that document while editing an item's metadata. It is the authoritative source for the 

rules your metadata content must follow. This may be difficult at first while you become 

accustomed to the standard's diagrams, notation, and terminology, but in the long run, this will 

help you create better metadata. 

Creating standard-compliant metadata in ArcGIS for Desktop 

To create standard-compliant metadata in ArcGIS for Desktop, first configure the software to use 

the appropriate metadata style for the standard or profile you need to follow. Then, the ArcGIS 

metadata editor can help you create standard-compliant metadata by checking content as you 

type. 

The table of contents lets you see at a glance if an item's metadata's satisfies all of a metadata 

style's rules. If there are any problems with the information provided on a page, the page will 

have a red X  in the table of contents. Pages with no errors have a green check 



mark  instead. A plain page  in the table of contents has no rules concerning the information 

it lets you manage. 

When there is a problem with an element's value it will have a red background. For example, the 

element might be required for your metadata style, but it has no content; or, an integer might be 

required in an element, but text was provided instead. If you see any problems, you can correct 

them immediately as you edit the item's metadata. If you're ever unsure of what information to 

provide in a metadata element, hover the pointer over its input control. A help string appears at 

the bottom of the editor explaining what information is expected. 

Some pages are long; you might not be able to see a problem right away. Therefore, a list of all 

errors that occur on a page is presented at the top. If you click an error in this list, the page will 

scroll to the place where you can fix that problem. 

 

As you edit the information on a page, the list of errors at the top will change automatically. 

Sometimes, when you set an element's value on one page this might cause error messages to 



appear on another page. Changing an element's value can cause new rules to be considered. 

When all errors on a page have been fixed, you'll see a green check mark on the page in the 

editor's table of contents. 

 

The rules that have been defined for a metadata style are based on the information provided in 

the metadata standard or profile documents as a whole. For the ISO 19139 metadata style, this 

includes rules defined in the ISO 19115, Geographic information — Metadata, and ISO 

19119, Geographic information — Services, content standards that can't be represented in the 

XML Schemas provided by ISO 19139, Geographic information — Metadata — XML schema 

implementation. For the North American Profile metadata style, this includes rules defined in the 

best practices that are not represented in the profile's UML models. For the INSPIRE metadata 

style, the INSPIRE Metadata Implementing Rules have been added to the rules required by ISO 

19139; the INSPIRE rules can't be considered exclusive of ISO 19139 since neither an INSPIRE-

specific metadata format nor a custom set of XML Schemas have been provided by that 

directive. 



Once you've created standard-compliant metadata describing an item, that information will 

accompany the item as it is managed and shared in ArcGIS. 

1. Configure ArcGIS to create metadata appropriately for the standard you need to follow. 

2. View the item's ArcGIS metadata. Many properties of the item are added automatically. 

3. If the item has existing metadata created with ArcGIS Desktop 9.3.1 or an earlier release, upgrade 

the item's metadata to the ArcGIS metadata format. 

4. Edit the item's metadata. Add whatever content is appropriate for your organization and for the 

item. After editing the information on a page, make sure no errors are listed at the top. 

o If no problems were found, the page will have a green check mark in the table of contents. 

Continue to the next step. 

o If problems were found, a list of errors appears at the top of the page. Correct each problem, 

then check the list again. Repeat until there are no problems on this page. 

5. Check the metadata editor's table of contents to see if any pages have a red X  indicating that 

there is a problem with the information on that page. 

o If all pages have green check marks , you've created standard-compliant metadata. 

Continue to the next step. 

o Repeat step 4 for each page on which errors were found. 

6. Click the Save button  to save your changes and stop editing the item's metadata. 

 

Validating an item's metadata 

When an item's metadata meets all of a standard's requirements, it is said to be valid. Some 

metadata standards have rules about the content that should be provided and no information 

about the format in which the metadata should be stored. Other standards may include rules 

about both the content and the format of the metadata. Any requirement concerning the format of 



the metadata may only be applied when that metadata is considered independent of the item that 

it describes. 

Both ISO 19115, Geographic information — Metadata, and the Federal Geographic Data 

Committee (FGDC) Content Standard for Digital Geospatial Metadata (CSDGM) are content 

standards. As long as all content requirements are satisfied, the metadata is considered to be 

valid, regardless of the format in which the information is provided. However, ISO 

19139, Geographic information — Metadata — XML schema implementation, provides a set of 

XML Schemas that specify how metadata following this standard should be stored in XML 

format and also how metadata should be tested to ensure compliance with the standard. 

Unfortunately, the XML Schema language itself is unable to fully capture all the rules described 

in ISO 19115, so the test specified by ISO 19139 is somewhat limited. 

Many different tests can be used to determine if an item's metadata is valid for a standard or 

profile. Each has advantages and limitations. XML DTDs can check if required metadata 

elements exist and verify they are in the correct place. XML Schemas perform the same type of 

tests and can additionally check if an element contains the correct type of value. XML Schemas 

can't test conditions where the optionality of an element may change depending on the value of 

another element. Some profiles may use Schematron rules, which can handle the types of 

conditions that XML Schemas are unable to verify and which can provide validation messages 

that are easier to understand. For FGDC metadata, the metadata parser utility, commonly known 

as mp, is typically used to test the structure and content of metadata stored in XML, structured 

text, or SGML format. However, an XML DTD and an XML Schema are also available to test 

FGDC metadata stored in XML format. Because of the differences in validation methods, each 

type of test might produce different results with the same XML file even if they are designed to 

support the same standard or profile. 

An ArcGIS item's description is stored in an internal, Esri-defined format. The validation tests 

associated with metadata standards are created to be used independently of ArcGIS with 

metadata that is formatted appropriately for that standard. ArcGIS comes with translators that 

know how to take the information you've provided and produce files that are formatted correctly 



for different metadata standards. If you want to validate an item's metadata using the XML 

Schema or XML DTD associated with your metadata style, use the Validate button in 

the Description tab. It opens and runs the Validate Metadata tool, which first exports metadata 

to a standard-compliant XML file, then validates the exported file. 

In general, if you are finished editing an item's metadata and the ArcGIS metadata editor shows 

that you've created standard-compliant metadata, these tests should pass. 

If you want to validate the item's metadata using a different XML schema than the one 

associated with your metadata style, identify its location in the Validate Metadata tool's Schema 

URL parameter. To validate the item's metadata using a different validation method, use 

the Export button in the Description tab. It opens and runs the Export Metadata tool to generate 

a standard-compliant XML file. Then, perform the other validation method. 

FGDC-format XML files can be validated with mp by running the USGS MP Metadata 

Translator tool with the noneconversion type. If you are using the FGDC metadata style, you 

might prefer to validate the item's metadata this way instead of using the FGDC CSDGM DTD 

or XML Schema. You can create your own model or script tool that first runs the Export 

Metadata tool to produce an FGDC-format XML file, then runs the USGS MP Metadata 

Translator tool to validate that file. If you need to produce metadata in the other FGDC CSDGM 

file formats, such as text, HTML, or SGML, these steps could be incorporated into the same 

model or script. 

Any XML file can be validated using an XML Schema or XML DTD with the XML Schema 

Validation tool. 

Validating an item's metadata is often an iterative process. You edit the item's metadata, then 

check if it is valid. After finding a validation error, you edit the metadata to correct the problem, 

save your changes, then validate it again. The information you provided to resolve the first set of 

issues may trigger other conditions causing additional information to be required. Once those 

issues are fixed, you may find another problem, and so on. 



1. Validate the item's metadata with the metadata style's XML schema to ensure you have created 

standard-compliant metadata. 

2. If any errors are reported in the tool's messages, identify the problem. 

An XML parser doesn't know anything about your metadata standard; it only knows how to evaluate 

the rules specified in an XML schema and report information about any problems in a generic manner. 

An XML schema has a list of elements that are allowed in a section in a specific order. It knows which 

elements are mandatory. It may know what type of data they are allowed to contain. 

Suppose a section is allowed to have elements A, B, and C, and B is mandatory, and you are testing 

metadata using an XML schema. If your metadata has elements A and C, but B is missing, you might 

expect to get an error message telling you that B is missing. Instead, the error message you usually get 

tells you that element C is out of order or is not allowed at that location. If your metadata only has 

element A, and B and C are both missing, you usually get a message saying that other elements are 

required in that section. If your metadata has element B, but its value is the wrong data type, you 

usually get a message telling you that element B's value is not allowed. Generally speaking, the 

validation messages tell you there is a problem but they may not help you fix it. 

If a validation error indicates there is a problem with a metadata element, look up the appropriate 

section in the metadata standard document. Find out which elements in that section are mandatory and 

what their data types are. Check the item's metadata to see which of those elements are present, which 

are missing, and if they contain the correct type of information. 

3. Edit the item's metadata. Add any missing information and correct any values that have the wrong 

data type. 

4. Click the Save button  to save your changes and stop editing the item's metadata. 

5. Repeat steps 1 through 4 until no validation error messages are reported. The item's metadata is 

valid according to the XML schema that you are using. 



Exporting and publishing a standard-compliant XML file 

If you share an item with another ArcGIS user, the standard-compliant metadata that is part of 

the item travels with it. If you publish the item to ArcGIS Online, you don't have to do anything 

special to publish the item's standard-compliant metadata; you simply publish the item itself. 

You might also share information describing the item outside of ArcGIS, separate from the item. 

For example, you might publish metadata to an independent metadata catalog such as the 

European INSPIRE geoportal or the United States GeoPlatform.gov. Metadata catalogs typically 

require information to be provided in a standard-compliant file format. If you want to publish 

information about the item to this type of metadata catalog, first export the item's metadata to the 

appropriate standard-compliant format, then publish the exported file. 

Metadata catalogs may incorporate tests that check if the file you are publishing complies with a 

standard. If your file doesn't pass the test, it won't be published. The test performed by the 

metadata catalog may not be the same test you are using to determine if your metadata is valid. 

The metadata catalog might also have requirements that go above and beyond a metadata 

standard's rules to ensure that all published metadata can be found with all of the search methods 

it supports. Whatever test the catalog's administrator requires is the test your metadata must pass. 

If possible, check if the item's metadata is valid for that metadata catalog using the appropriate 

test before you try to publish it. If any problems are found, edit the item's metadata to correct 

them, then rerun the test. 

1. Validate the item's metadata using the metadata catalog's validation test. If any errors are reported, 

identify what they are and edit the item's metadata to correct the problems. 

2. Export the item's metadata to a standard-compliant XML file. 

3. Publish the exported file using the publishing mechanisms provided by the metadata catalog. 

Note: 

If you have been creating and managing FGDC metadata for a long time, implementing changes 

to your workflow for creating standard-compliant FGDC metadata might seem daunting at first. 



You can continue editing metadata in the current release of ArcGIS for Desktop using the add-

in that provides the 9.3.1 FGDC metadata editor. However, if you do this, you can't manage your 

metadata using the buttons in the Description tab. To export information stored in the FGDC-

format metadata elements to a separate FGDC-compliant XML file, use the USGS MP Metadata 

Translator tool with the XML conversion type. Also, the content that is available in the add-in 

won't stay updated with the item's current properties. Once you become accustomed to the new 

metadata editor, you'll find it easier to create standard-compliant metadata with the current 

version of ArcGIS for Desktop than with ArcGIS Desktop 9.3.1. 

About validating metadata 

 How an item's metadata is validated 

Validating metadata is a task you typically perform only if you must create metadata that 

conforms to a metadata standard. Validate after completing an item's metadata but before 

handing off your work. For example, if you plan to publish an item's description to a metadata 

catalog, validate an item's metadata before you publish it. 

In ArcGIS, metadata is created and validated following the guidelines of the metadata standard 

associated with the current ArcGIS metadata style. The ArcGIS metadata editor checks the 

information you provide as you edit the item's description. When you are finished editing the 

item's metadata, you can validate it against an XML schema. Click the Validate button in 

the Description tab to validate the item's metadata for your metadata style. The item's metadata 

will be tested using the XML Schema or the XML DTD specified by the metadata standard 

associated with the metadata style. 

Administrators of metadata catalogs often require metadata to be valid according to a specific 

test before they will publish it. In this case, the catalog administrator's test is the requirement you 

must satisfy regardless of what the standard's rules are and what validation mechanisms are 

specified by the standard. After clicking the Validate button, you can change the XML schema 

that will be used to test the metadata by providing the location of the catalog's XML schema in 

the Validate Metadata tool's Schema URL parameter. 



Validating an item's metadata is often an iterative process. You edit the item's metadata, then 

check if it is valid. After finding a validation error, you edit the metadata to correct the problem, 

save your changes, then validate it again. The information you provided to resolve the first set of 

issues may trigger other conditions causing additional information to be required. Once those 

issues are fixed, you may find another problem, and so on. 

If your organization creates GIS resources and makes them available to others, you are often 

updating the data constantly. Current descriptions for these resources can be posted regularly—

maybe even daily. After ensuring an item's metadata is valid, chances are the regular updates 

required to keep the metadata current with the properties of the item won't make the metadata 

invalid. However, if you want to confirm that the metadata for these items is valid before 

publishing their updated metadata, select all the items in ArcCatalog and use the Validate 

Metadata button on the Metadata toolbar to check them all at once. 

How an item's metadata is validated 

An ArcGIS item's metadata is always stored in an internal, Esri-defined format. Even if other 

standard-compliant XML elements are added to the item's metadata, they will still be combined 

with internal Esri-defined content stored in Esri-defined XML elements. As a result, the item's 

metadata cannot be directly validated using a metadata standard's XML schema. 

To validate an item's metadata, it first must be exported from ArcGIS to the appropriate storage 

format, then the exported XML file can be validated. An ArcGIS metadata style can define how 

to export metadata from ArcGIS to a standard-compliant XML format and identify an XML 

schema that can be used to validate the exported file. A shortcut is provided in ArcGIS for 

Desktop that prevents you from having to perform the export and validation steps separately. 

When you validate metadata using the Validate Metadata button on the Metadata toolbar or 

the Validate button in the Description tab, an item's metadata is exported and validated as 

determined by the current metadata style in one step. 

When you use the Validate or Validate Metadata buttons, the Translator, Schema URL, 

and Namespace URI tool parameters are populated appropriately based on the properties of the 



current metadata style. Translator determines how the metadata is exported. Schema 

URL determines the XML schema used for validation. Namespace URI determines the XML 

namespace in the exported XML file that will be validated by an XML Schema, if appropriate. If 

you validate using an XML DTD, Namespace URI identifies the root element of the XML 

document that will be validated, which should match the root element specified in the DTD. 

If you open the metadata validation geoprocessing tools from the Search window, or 

the ArcToolbox window, or you run the tools using Python, the metadata style is not consulted 

and default values won't be available for the tool parameters. 

Note: 

If the item you've selected in ArcGIS is a stand-alone metadata XML file that is already in the 

correct format for a metadata standard, validate it directly against the appropriate schema using 

the XML Schema Validation tool not using the Validate Metadata tool. XML files that follow a 

metadata standard's format contain no ArcGIS metadata that must first be exported before the 

content can be validated. 

Validating metadata from the Description tab 

Validate metadata from the Description tab to check if the information you've provided 

conforms to the guidelines of a metadata standard or profile. If any problems are found, edit the 

metadata to correct them. 

1. In the Catalog window, click the item whose metadata you want to validate. 

2. View the item's metadata. 

3. Click the Validate button . 



 

The Validate Metadata tool opens. The Translator, Schema URL, and Namespace URI parameters 

are populated with appropriate values for your metadata style. 

4. Provide an appropriate name for the stand-alone metadata XML file that will be created in 

the Output File text box. 

5. Click OK. 

Stand-alone metadata XML files are created as specified by the tool parameters that are formatted 

appropriately for your metadata style. These files are then validated appropriately for your metadata 

style. The tool's messages will indicate if the metadata is valid or if any problems were found. 

Validating metadata from the Metadata toolbar 

Validate metadata from the Metadata toolbar as part of a routine operation for publishing the 

most current version of your metadata. 

1. In the ArcCatalog Contents tab, press the CTRL key while clicking the ArcGIS items whose metadata 

you want to validate. 

2. Click the Validate Metadata button  on the Metadata toolbar. 

If one item is selected, the Validate Metadata tool opens. If many items are selected, the Validate 

Metadata Multipletool opens. The Translator, Schema URL, and Namespace URI parameters are 

populated with values determined by the metadata style. 



3. Provide an appropriate location and file name, if appropriate, for the stand-alone metadata XML files 

that will be created. 

o In the Validate Metadata tool, provide an appropriate Output File name. 

o In the Validate Metadata Multiple tool, provide an appropriate Output Folder name. 

4. Click OK. 

Stand-alone metadata XML files are created as specified by the tool parameters that are formatted 

appropriately for your metadata style. These files are then validated appropriately for your metadata 

style. The tool's messages will indicate if the metadata is valid or if any problems were found. 

Validating metadata 

 XML Schema Validation 

 Validate Metadata and Validate Metadata Multiple 

 ESRI Metadata Translator 

 USGS MP Metadata Translator 

ArcGIS metadata is created following the guidelines of the metadata standard associated with the 

current ArcGIS metadata style. Validating metadata is the process of checking to see if it follows 

the guidelines of a metadata standard. A variety of geoprocessing tools are available that validate 

metadata in different ways. 

XML Schema Validation 

XML Schema Validation is a generic tool that checks if an XML file follows the structure and 

content rules defined in an XML Schema or an XML DTD. This tool is not specific to validating 

metadata—it can be used with any XML file. Any problems found when validating the file are 

reported as part of the tool's messages. 

ArcGIS metadata is not stored in a manner that can be directly validated using a metadata 

standard's XML schema. Do not attempt to directly validate an ArcGIS item's metadata using 

this tool. 



Validate Metadata and Validate Metadata Multiple 

Validate Metadata and Validate Metadata Multiple export ArcGIS metadata to stand-alone 

metadata XML files then validate the exported XML file using an XML schema. 

Use Validate Metadata to validate one ArcGIS item's metadata and Validate Metadata 

Multiple to validate several ArcGIS items' metadata at once. 

Metadata that is formatted following a metadata standard's XML schema can be directly 

validated against that standard's XML Schema or DTD; validate these files using the XML 

Schema Validation tool. Do not validate these files using the Validate Metadata or Validate 

Metadata Multiple tools. 

There are different ways in which the dialog box for these tools can be opened. The default 

values used in the tool may be different depending on how the tool is opened: 

 Tools can be opened directly from the Catalog window by opening the Conversion toolbox in the 

System Toolboxes folder. Opened this way, the Translator, Schema URL, and Namespace 

URI parameters are not predefined. 

 Tools can be opened from the ArcToolbox window by opening the Conversion toolbox. Opened this 

way, the Translator, Schema URL, and Namespace URI parameters are not predefined. 

 In the Search window if you search for tools using the phrase validate metadata, the search 

results will include the Validate Metadata and Validate Metadata Multiple tools. Clicking a tool's 

name in the Search results opens the tool. The Translator, Schema URL, and Namespace 

URI parameters are not predefined. 

 View an item's metadata, then click the Validate button in the Description tab. 

The Translator, Schema URL, and Namespace URI parameters are set to the appropriate value for 

the current ArcGIS metadata style. 

 Click the Validate Metadata button on the Metadata toolbar in ArcCatalog. The Translator, Schema 

URL, and Namespace URI parameters are set to the appropriate value for the current ArcGIS 

metadata style. 



After validating the metadata, you can decide whether you want to keep the exported XML file. 

ESRI Metadata Translator 

The ESRI Metadata Translator tool's primary function is to export ArcGIS metadata to an XML 

file that is formatted to follow a metadata standard's XML schema. 

However, as part of the exporting process, this tool's translation engine assesses an entire 

metadata document using its specialized validation rules and reports any problems it finds when 

the following translators are used: ArcGIS or ESRI-ISO to ISO 19139, ISO 19139 to ArcGIS, 

FGDC to ArcGIS, and FGDC to ISO 19139. These validation rules include those specified in the 

metadata standard documents that may not be possible to encode in an XML Schema. For 

example, a set of rules laid out in the standard might apply only if a metadata element has a 

certain value. In some situations, elements that are conditionally required are defined as optional 

in an XML Schema. 

Any validation warnings found by this tool are reported as part of the tool's messages. The 

validation warnings can also be saved to a log file that you can refer to later, for example, when 

editing the metadata. 

USGS MP Metadata Translator 

USGS MP Metadata Translator uses metadata elements in an item's metadata or an XML file that 

follow the Federal Geographic Data Committee's (FGDC) Content Standard for Digital 

Geospatial Metadata (CSDGM) XML format. If this content is present in an item's metadata, it 

appears under the FGDC Metadata (read-only) heading in the Description tab when you are 

using a metadata style that gives you full access to the item's metadata. 

For example, if the metadata that was created in ArcGIS Desktop 9.3.1 or earlier using the 

FGDC metadata editor and the item's metadata has been upgraded to ArcGIS metadata, the 

ArcGIS metadata will continue to include the original FGDC metadata XML elements. In this 

example, this tool would only export the original FGDC metadata. This content may also have 



been provided using the FGDC metadata editor add-in with the current release of ArcGIS for 

Desktop. 

Similarly, this tool can be used to validate stand-alone metadata XML files that were created 

outside ArcGIS following the FGDC CSDGM metadata format. 

This tool exports and validates FGDC metadata using the metadata parser utility known as mp. If 

the tool's Conversion Typeis set to NONE, only metadata validation is performed. When using 

this tool, any validation warnings or errors are reported in the tool's messages if a log file isn't 

specified in which mp's messages can be stored. Save mp's validation warnings and errors to a 

log file that you can refer to while updating the item's metadata. 

 

Printing metadata 

Having a printed copy of an item's metadata can be useful as an inventory of your organization's 

data holdings or as a reference to use when checking the quality of the item's attribute or feature 

data. When you print a copy of an item's metadata, it will print exactly as it appears. 

1. In the Catalog window, click the item whose metadata you want to print. 

2. View the item's metadata. 

3. Click the Print button  in the Description tab. 

The Print dialog box appears showing the appropriate settings for your default printer. 

 



4. Set the printer properties and determine how you want your metadata to be printed. 

5. Click Print. 

The metadata is printed. 

 

Creating a metadata template 

When you need to create metadata for many ArcGIS items, it helps to streamline the task by 

creating a metadata template. Like a map document template or Word document template, a 

metadata template contains information that will be used again and again. With ArcGIS 

automatically updating properties of an item and metadata templates in place, it takes much less 

effort to complete an item's metadata. You can focus on documenting important information like 

the sources and quality of your data. 

An organization-wide template can include general contact and distribution information and 

legal restrictions. This can be the basis for other templates associated with specific projects. A 

project template might add keywords describing the geographic location, the purpose for which 

the items were created, how the resources will be maintained, and so on. In general, templates 

should not include properties that are automatically updated by ArcGIS. 

For a series of images or a data product with tiles of features covering a large area, in general, a 

stand-alone metadata XML file describing the entire series or data product should be sufficient, 

especially when publishing the information to a metadata catalog. If you must provide metadata 

at the level of the individual image or tile, templates can be used to transfer common information 

to the individual items. In scenarios like this, it is appropriate to include some properties in the 

template such as descriptions of fields and their values. Information unique to an item can be 

added with automatic updates and with the metadata editing pages available in 

the Description tab; a tile's extent will be added automatically, and you can append a key or 

phrase to the default title that identifies the individual tile with the Item Description page. 



If you've already fully documented an ArcGIS item, you can use that information as the basis for 

a metadata template. Run the XSLT Transformation tool with the generate metadata 

template.xslt file provided in the <ArcGIS Install 

Location>\Metadata\Stylesheets\gpTools folder. It will create a stand-alone metadata 

XML file that doesn't include unique identifiers or any automatically added content. Edit the 

XML file and remove or change any information that only applies to one item. Printing the 

metadata may help you identify information you don't want to include. 

Once a template has been created, use it by importing it to an ArcGIS item using 

the FROM_ARCGIS import type. 

1. In the Catalog window, right-click the folder where you want to store the metadata template. 

2. Click New > XML Document. 

A new XML file  with the default name New_XML_Document.xml is created in the folder. The 

item's name can instantly be modified to something more appropriate. 

3. Type an appropriate name for the metadata template. 

4. Press ENTER. 

5. View the XML file as metadata. 

The file doesn't contain any information to display in the Description tab. 

6. Click the Edit button  in the Description tab. 

7. Type in appropriate content for this metadata template. 

8. Click the Save button  in the Description tab. 

The contents of the metadata template will be displayed. 

Import this template to an ArcGIS item by clicking the item in the Catalog window, clicking 

the Import button  in the Description tab and using the FROM_ARCGIS import type. 


